Manual Dimensions

19. Manual Dimensions

19.1

Introduction

Besides the CMM (machine) dimensions and the calculated dimensions
discussed in the previous section, you can add what are known as Manual
Dimensions. They are called manual dimensions because you must enter these
values manually. Most times these values are collected using a hand-held gage
and you want them stored with your CMM data to complete the part. Manual
Dimensions are useful for adding features that are not available from a CMM and
are measured using another such as a hardness value, a chemical reading, or
color value, etc.

QC-CALC can also include dimensions that are calculated as described in the
Calculated Dimensions section on page 96. This means QC-CALC has a total of
3 different measurement types plotted in Real-Time.

* Machine Dimension Received from your CMM part program
* Calculated Dimension Extra dimension calculated by QC-CALC
¢ Manual Dimension Extra dimension typed by you

This unique capability means you can add separate features to your existing QC-
CALC file that cannot be measured on your CMM.

There are actually a couple of ways to add manual dimensions while you are
inspecting your parts. These are listed below in order or recommended use. The
most recommended is first.

* QC-Gage via MultiSource — This is the best way to enter manual
measurements because it allows you the most flexibility when it comes to
validation of the measurements taken. It also allows for a level of
automation since QC-Gage can collect data from small measurement
devices and specialized machines (such as hardness, roundness,
surface finish gages, etc) via RS-232, TCP/IP, and file based outputs. As
of QC-CALC 3.3, there is a new feature called MultiSource which allows
your QCC files to literally have multiple sources. For instance, a QCC file
with 10 dimensions could have 3 coming from a CMM, 5 coming from a
video measurement system and the last 2 coming from QC-Gage (via
manually entered values or a wireless micrometer). For more information
on this, please consult Prolink for a demo.

* Manual Input Screen — This screen is great for entering trace fields
(factors) for your parts when your inspection equipment does not have
the ability to provide them. For instance, your inspection equipment can
output the measurements directly into QC-CALC, but does not have the
ability to allow your inspectors to enter the lot number, fixture, machine
or other traceability info. It is also good for quickly entering manual
dimensions when you don’t want to use QC-Gage. It also allows you to
validate manual dimensions as a percentage to help prevent mistyped
values, combine trace fields and manual dimensions into the same
screen, choose values from a list for better consistency, and it can be
launched at regular measurement intervals (such as every 5 parts).

* Manual Dimension Values Screen — This screen is the original way of
entering manual data and is the simplest of the manual data entry
options. It simply gives you a column of cells for each manual dimension.
You can then type the values directly into the cells. There is no validation
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on the data and the values are plotted immediately upon pressing the
Enter key on your keyboard.

In this section, the first of the manual options will not be discussed since it
involves QC-Gage as an outside product.

Whether you decide to use the Manual Input screen or the Manual Dimension
Values screen, the first thing you need to do is modify the database and create
the dimensions that will be manually entered and ready them for the data to
come. The next three sections cover this task and are followed by the two
options so you can make an accurate choice based on your needs.

19.2 Adding the Extra Features

When we discussed adding an extra dimension in the Calculated Dimensions
section on page 96, we added 1 Manual dimension and did not discuss anything
further about it. Briefly, to add a Manual dimension, select File — Modify
Database Structure and then select the Database Settings tab. Change the
Manual Dimensions 1 to add one new dimension to the database. Again, review
the Calculated section for more details.

LCurrent Settingsi Databagze Properties  Databasze Settings |

~ Mumber of... —MNumber of...

Records [1 - 2,000,000) I 2000000 Mumeric Factars
Test Factor Width [1 -50] I 20 Text Factors

- Dimensions- 1~ Mumber of...

Machine [0 - 3000) i & Assignable Causes
Manual [0 - 1000) I 1
Calculated [0 - 1000) l

Restare Defaultz

19.3 View the Extra Dimension

The Real-Time Plots screen now shows the two extra plots we added. Note the
data line is flat since we had collected 11 parts before adding these extra two
dimensions. QC-CALC back fills the new dimensions with nominal values.

| Bl QC-CALT Real-Time (34.6) - [CAProlink\QC-CALC 3.4\Data\My Part 100.0cc]
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19.4 Scale the Plot

Right click on the Manual dimension and select Plot Properties. Assuming this
new dimension has a nominal of 0.5000 and the upper and lower tolerance to be
+/- 0.01 we entered these values into the Point Property screen. The control
limits were entered at 80% of the upper and lower specification limit or 0.508 and
0.492. The plot is red because all values are set to zero and must be updated.
Press the F7 key to stop editing the Plot Properties and your plot is now ready.

File View Report Export GageR&IR Tools Administrative Tools Help
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19.5 Entering Data via Manual Input Screen
The Manual InpUt screen (MIS) giveS you an Group Shopfloor] - [C\Prolink\QC-CALC 3.4\Data\Sample.qcc]

interface to enter extra data into a file that o =5 imststive Tools  Help
already contains the data from the CMM [  Trend Detection (0F)
machine. Normally a CMM machine | Setup Trend Detection...
automatically measures a part and sends the —| 5. Ticnd Detection Defaults...
data over to QC-Calc to be analyzed and —
displayed. For this process everything is
done automatically. Now, what if, in addition
to automatic part checks, you have to check
parts with a different machine or by hand (Ex.

v Manual Input (On]
Setup Manual Input...
Set Manual Input Defaults...

Reset Manual Input Counter

microscope) where no automatic output Pre-Control Zones
feature exits? The Manual Input screen gives Auto Archive
you the ability to enter these values into the Archive Now
same file as the CMM data. This needs to be Reset Archiving

set up so it launches at the right time and for the right number of parts.

19.5.1 Setup Manual Input

To set up the Manual Input screen, choose Tools — Set up Manual Input and
the setup screen will launch. There are two sections to this screen; Settings and
Input Values.
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At the top of the screen, a checkbox labeled Use default Manual Input settings
allows you to either use the defaults set in the Tools — Options area or override
the settings for this specific QCC file.

.—h-r. ual T ..';-_r;a'n;@

Use default Manual Input settings

The manual input screen iz useful for entering manual dimensions and factors that are not
automatically zent from pour inspection equipment. This screen allows pou to set up the manual
inputs that will be prampted during data collection.

The manual input screen iz launched at the beginning of each batch of parts after the first part
iz received from your inspection equipment. When the manual input screen iz vizible data
collection and reparts are paused temporarily in order to allow you to input your values. The
number of partg in vour batch (and therefore the frequency of the soreen) is determined below,
Within each manual input pou set up, vou can optiohally choose to specify less parts or to copy
the walue for all parts in your batch,

Nurnber of Records 5

Grid Mavigation Enter key goes to nest row

W alidate Manual Dimensions

150

©©

Restore Defaults Save Cancel

First, set the Number of Records option to tell QC-CALC how often to launch
this screen. In the picture above, this has been set to 5. This means the screen
will launch every 5 parts to ask for manual values to be entered. It is important to
understand that it will launch at the beginning of each group of 5 parts. When the
data is entered, the values will then be applied to the next 5 parts as they arrive.
If you shut down QC-CALC or change QCC files by inspecting different
parts, it will not remember the manual values entered so it is important to
enter the data and measure the parts together before switching parts.

The Grid Navigation choice controls how the screen behaves when asking for
values.

The Validate Manual Dimensions option instructs QC-CALC to validate the
dimensions being entered. This is set as a percent of tolerance. Therefore, if you
set it at 150%, then it will warn you if a number that is typed is outside 150% on
either side of tolerance. This is meant to prevent wildly out of tolerance values
such as a misplaced decimal point (typing 11 instead of 1.1).
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The bottom section of the screen is where you set up the actual data points
(dimensions and factors) that will be manually entered. To add entries, click the
green plus icon and the Manual Input Editor screen will be displayed.

This screen allows you to set up an individual manual input. Choose the manual input type and an available location
below. Then fill out the corresponding settings and dick OK. If there are no available locations you will need to
create the location. This is done in the Modify Database Structure screen from the File menu.

Details Entry Options
Manual Input Type B
Available Locations Manual Feature 1 - ManDimension 1 | = @) Enter individual values
User Prampt Number of Entries 5
Required

Manual Dimension Options
Dimension Entry Mormal Mumeric Entry

Default Value 0

oK Cancel

Details

Manual Input Type

This screen allows you to enter either Manual Dimensions or Factors
(Numeric or Text). Some of the remaining settings on this screen will change
depending on the choice made here.

Available Locations

This is the location where the entered data will be placed. It can either be a
Factor or a Manual Dimension.

User Prompt

This is the message the user will see. Enter something friendly like “Please
type the serial number of the part” or “Please bar code scan your badge” to
lead the operator through the process.

Required

With this option checked the operator will not be able to close the Manual
Input Screen unless this value has been entered.

Entry Options

Enter one value for entire batch

This choice is only available for Factors. With this option chosen the value
entered into the Manual Input Screen will be used for all records in the
session. This is useful for things like “Operator Name” and “Lot Number”
where the same value applies to everything in this session.

Enter individual values

This is available for both Factors and Manual Dimensions. When this option
is chosen you will need to enter the Number of Entries (records) that will be
required on the Manual Input Screen. This number may be less than the total
Number of Records entered into the Manual Input Setup screen.

For instance, you may want to launch the screen every 5 parts, but only want
to manually measure the first 3 of those parts for a particular Manual
Dimension. In this case, the Number of Records on the main Manual Input
Setup screen would be 5 and the Number of Entries for this Manual
Dimension would be 3. If you want to have the operator fill in data for all parts
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in the session, make sure the Number of Entries number matches the
Number of Records.

The entries are always at the beginning of the sample set. Therefore, if the
frequency is 5 and a dimension has the Entries set as 3, it is always the first
three parts that will have a value for the dimension and the remaining 2 will
not be used (a Null value for Text Factors, 0 for Numeric Factors, or set to
Nominal and Marked as Deleted for Manual Dimensions).

Note: Each different type of data entry point can have its own value for
I Entries. This allows you to set up some of your factors for all parts, but other
dimensions for only some of your parts.

Remember last value for next batch

This choice is only available for Factors. With this option chosen the value
entered into the Manual Input Screen during the last session will
automatically populate the Manual Input Screen during the next session. This
value can be changed if necessary, but it many cases it is a good starting
point.

Manual Dimension Options

Dimension Entry
There are 3 choices for this option:

* Normal Numeric Entry — With this option the operator would just
type in the number for this dimension.

» Enter as Pass or Fail — With this option the operator would be given
a choice of “Pass” or “Fail” only.

« Enter as Pass or Fail with N/A option — With this option the
operator would be given a choice of “Pass” or “Fail” or “N/A”.

Default Value

This is simply the default value of the dimension. When the screen launches,
cells with default values are pre-populated allowing the operator to enter the
data only if it changes.

Factor Options

Choose from list

This option allows you to force the operator to choose the value from a list.
This is useful for repeating values such as operator names or machine
numbers where there is a finite list of items from which to choose. It helps to
provide consistency in your data making filtering easier later.

Note: It is always recommended that you use lists when possible, especially

@ for typed values such as names. Often operators will spell their names
differently depending on mood or time of day (initials, first name, etc). By
forcing a list, it ensures the data will be entered the same every time.

Default Value

This is simply the default value of the factor. When the screen launches, cells
with default values are pre-populated allowing the operator to enter the data
only if it changes.

19.5.2 Turning Manual Input On/Off

The Manual Input functionality is turned on and off via the Tools — Manual Input
menu. Simply click it in the Tools menu to activate or deactivate the MIS.
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19.6 Entering Data via Manual Dimension Values Screen

To add data into this Manual dimension, select Manual Dimension Values from
the View menu and a spreadsheet “like” grid is displayed. The grid contains the
same number of values as displayed points. As you type the number into the
grid, you will see the plot updating. Should you make a mistake, move up in the
grid and change your entry.

)C-CALC
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Remember, QC-CALC stores the manually entered results in the database so
you can treat the manual dimension the same as any other dimension.
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